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Tutorial Four:

Comparison of 
OEM vs Third-
Party Inks

This project will analyze the quality of target image reproduction printed 
with Office Depot 57/58 inks and with HP 57/58 inks.  Both samples were 
printed from Adobe Photoshop on the HP Deskjet 6540 using printer man-
aged colors.  The targets have dimensions of 25 rows by 32 columns.  The 
Examples folder contains i-Star screen captures of both targets and the data 
necessary to follow this example.  The purpose of this project is to analyze 
and quantify the deviations between prints made with OEM inks and those 
made with a Third Party ink set.

Initially, collect the necessary data using an appropriate tool.  The spectral 
data supplied in the Examples folder has been collected using Gretag Macbeth 
Spectrochart Lite software and Gretag Macbeth Spectrolino spectrophotom-
eters.  Because the spectral data is supplied for this project, these steps are 
omitted. Guidance for data collection can be found in specific instrument and 
software manuals.

Now, begin this project.

Start i-Star

Fig. 1
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Click on the i-Star executable file.  See (Fig. 1).  For convenience, create a 
shortcut to the application on the desktop.  

Create a new project.

Press Ctrl + n or choose “New Project” in “Project” menu.  A request for 
a reference measurement will appear.  This measurement is considered the 
“ideal” or starting point.  Choose Glossy Photo Paper with its appropriate 
printer profile as the reference measurement.

Choose “HP57_58inks.xls” in the open file dialog.

i-Star will process and report the file on the “Data Layout” page.  A warn-
ing will appear requiring specific information.  See (Fig. 3).

Fig. 2

Fig. 3

This warning means the data collecting software did not report the number 
of columns and rows in the output file.  Fill in the “Number of Rows” and 
“Number of Columns” fields.  See (Fig. 4).  The originating data targets con-
tain 25 rows and 32 columns each.  

Enter the number of rows and columns in the appropriate fields.
Press “Proceed” button.
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i-Star will interpret the data contained in the file and evaluate the param-
eters for all predefined regions of interest.  Unless the option is disabled, a 
message to check (and possibly reassign) the color map values of the target 
will appear.

The color map values may be changed on the “Project Color Map” tab of 
the “Preferences” page.

Press F2 or choose “Preferences” in the i-Star menu.
Navigate to “Project Color Map” tab.  See (Fig. 5).

i-Star must have values for the lightest and darkest (Lmax and Lmin) 
patches on the target.  When using an ideal paper (extremely white paper) and 
an ideal ink set (an ink set capable of producing pure black), the measured 
values of Lmin and Lmax will range from 0 and 100.  This scenario is almost 
never the case, so the tonal scale for the target must be set for i-Star.  

The first option, “Defined by user,” allows manual setting of reasonable 
values for the test.

 
“Defined by image,” will analyze the image and assign values automati-

cally.

Fig. 4
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“Defined by map” uses a percentage of patches from the target for each 
L extreme and computes a mean value.  This percentage of patches is set in 
the text box after the “Mark Extreme” button.  For this example, use a value 
of 1%.  The Lmax is the average value of the brightest 1% of the patches on 
our target.  Lmin is the average value of the darkest 1% of the patches on our 
target.

Depending on preferences and the nature of the test, choose one method.  
In this example, use the “Defined by map” option to calculate the Lmin and 
Lmax values by finding the average L values for the darkest and lightest 1% 
of the patches on the target, respectively. 

Choose “Defined by map” for both black and white patches.
Click “Mark Extreme” button for a value of 1%.
Apply changes.

The i-Star targets offer a broad selection of hues and tones to study and 
tools to select custom regions of the color space for evaluation.  For this test, 
the regions of interest are the complete data set, neutrals, and near neutrals.  
Additionally, evaluate the differences between the patches with Lmin and 
Lmax.  Many of these regions are mathematically defined with the i-Star ap-
plication, but spatial redefinition may be useful.

Fig. 5
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Navigate to “Project Crops” tab.

Fig. 6

Fig. 7
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The “Project Crops” function allows the creation of a spatial region of 
interest.  The chart on the previous page show which patches are contained 
in each of the regions of interest.  Create a custom crop for skin tones, near-
neutrals, neutrals, and the Lmin and Lmax patch groups.  See (Fig. 6&7).

First, create the region including skin tones.  Skin tones are located in the 
last four columns of the target.  Double-click on any of those patches.  This 
will demarcate the patch with an “X.”  All patches marked with an “X” will 
be included in the region.  To simplify, select the entire region for inclusion in 
the custom crop, and click on the “Mark selected” button.

Select the last four columns of target.
Click “Mark selected” button.

Now that all necessary patches are marked, save them as a region of in-
terest - or in this case, a custom crop.  “Custom crops” are spatially defined, 
target dependent regions of interest.  The term “region of interest” refers to 
mathematically defined regions on a test target.

Click “Add” button.
Enter “cc_skintones” in box.

To complete the process, name the remaining groups of patches, “cc_neu-
trals,” “cc_lmax,“ and “cc_lmin.” 

The remaining files have the same geometry as the initial file, so safe ac-
tivation of the Data Import Assumptions (DIA) engine is possible.  The DIA 
engine makes assumptions about the size and measurement parameters of the 
targets based on the reference file for the i-Star project.  Consequently, before 
employing the DIA, verify the data compatibility for each measurement.  Data 
may not be compatible if measurements were gathered using different mea-
suring devices or software.  The check boxes in the “Data import options” sec-
tion will assist in verifying that the data meets necessary criteria for accurate 
comparison.  See (Fig. 8).

Navigate to “Data import options” sub-tab on “General” tab.
Activate all assumptions, and select the sequence of patches for left-to-

right.
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Deactivate “Import only user confirmed data” option.

Fig. 8

Activation of the “Import only user confirmed data” option allows for ad-
ditional modification from the “Data Layout” page after completion of the 
DIA engine cycle.  

Return to “Project Description” page.
Press F2 or choose “Preferences” in i-Star menu.

Because i-Star calculates results based on parameters set in the “Preferenc-
es” page, any data-related change requires a recalculation of values.  Because 
the color map was modified, recalculate the averaged data for the project.  The 
remainder of files have the same geometry as the initial one, so activate the 
DIA engine. 

Press F7 or select “Recalculate Project” in “Project” menu.

Fig. 9

Once the recalculation is complete, a notification will appear.  See (Fig. 
9).
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i-Star will process the file and report on the “Data Layout” page.  Return to  
“Project Description” page.

Now that all files have been imported, the data is ready for analysis.  Before 
analysis, check the “Target Model” window.  This window shows the visual 
representation of imported data and must look exactly like the target used for 
data collection.  See (Fig. 11).

Press Ctrl + t, or select “Target Model Window” in “View” menu.

The target window now shows the reference target, i.e. the print with 
HP57_58 inks.  This window offers a number of controls, all described in the 

Fig. 10

Press Ctrl + a or choose “Add to Project” in “Files” menu.
Choose “Officedepot57_58.xls” in the open file dialog.  See (Fig. 10).

Fig. 11
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i-Star User Guide.  The first control changes the file (and the corresponding 
target) represented by the image on the screen.

View the target model for Office Depot ink print.  See (Fig. 12).

Select “Officedepot57_58inks.xls” in the first drop down list.

The second drop down list changes the region of interest/custom crop rep-
resented in the “Target Model” window.  

View “General Skintones” region.
Select “General Skintones“ in the second drop down list.  See (Fig. 13).

The target model now shows only those patches which LAB values satisfy 
the condition for General Skintones.  The grid on the Target model window 
can be removed anytime.  To toggle the appearance of the grid, press g.

Fig. 12
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After verification of all imported data, close the “Target Model” window.   
In some instances, the “Target Model” window will be opened much sooner.  
For example, data sets imported from multiple measuring systems and associ-
ated software will require the “Target Model” window.

Press g.
Close “Target Model” window.

Next, consider the project charts.  i-Star provides a number of easy chart-
ing options include spectral and hue angle distributions, i-Star component de-
velopment and results, tonal reproduction charts, and component histograms.  
Custom specifications of the charts is possible, so becoming familiar with the 
manual entries of factors will lead to greater efficiency.  The “Chart” window 
consists of a single page with the “Settings” and “Chart” tabs.  The “Chart” 
tab contains the chart and a lower panel with controls.  Right-click any unused 
surface on the lower panel to access the chart selection menu which contain 
choices for all available charts.  The “Settings” tab contains all controls for 
the appearance of charts.  The individual group box titles indicate settings for 
the charts.

Press Ctrl + g
Navigate to “Settings” tab.

In the I* Component Results and Averaged Parameter Development check 
the boxes for I*color full, I*tone full, I*total, and Quality Control for I*tone, 
I*color, Brightness Factor full, and Contrast Factor full.  See (Fig. 14).

Fig. 13
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The chart window will allow easy interpretation of both measurements and 
trend lines.  See (Fig. 15).  Click on each data point and the status bar will 
show the corresponding file and x,y coordinates.

Navigate to “Chart” tab. 
Check “Show legend” box.

Fig. 14

Fig. 15

Notice the “Brightness Factor full” (yellow line) is down to approximately 
98% for the bond paper.  These results indicate that the Office Depot inks were 
able to produce 98% of the brightness achieved on the HP inks when printing 
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the same target.  All results are averaged over the whole target.  To analyze the 
results from a specific region of interest, explore the “Region of Interest” drop 
down list.  The “Contrast Factor” performed at approximately 90% using Of-
fice depot inks.  This trend results from the Office Depot inks being incapable 
of producing colors as dark (L channel) as HP inks.  Due to the Office Depot 
inks not producing lower Lmin values, the level of definition between lighter 
and darker portions of the target where not as high as the HP inks.  “I*color 
Full” (green line) dropped to 80% indicating that in comparison to the photo 
paper, the bond paper color hues shifted, on average, by 20%.

    
“I*tone Full” dropped to 85% showing that, on average, the bond paper 

could not reproduce the tonal scale of the photo paper.  Specifically, there was 
an average difference of approximately 15% between the L value of any given 
patch printed using HP inks and the same patch printed using Office Depot 
inks.

i-Star can also analyze data for a chosen color space region of interest. 
Consider the region of skin tones as defined in the template.

Check the spectral distributions for some skin tone patches.  i-Star provides 
spectral distribution charts, provided the spectral data was imported.  Proceed 
with analysis of these charts.  See (Fig.16).

Fig. 16
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Right-click on the panel and select “Spectral Distribution” in “Context 
Menu.”

Change the column value to 30 and the row value to 19.

The spectral distributions for the two inks show that the patch at column 
30 and row 19 (this is a skin tone patch) was reproduced by Office Depot ink 
at approximately the spectral intensity of the HP inks across all wavelengths.  
Minimal deviation occurred between 540 and 600 nanometers where  HP inks 
produced higher intensities. 

  
Experiment with other row/column values and observe the spectral distri-

bution changes.

Finally, save the project.  This allows access to data easily without having 
to reenter any information.  i-Star will save the complete set of data, a snap-
shot of the settings, and the results of all calculations.  Please note that i-Star 
will not save any open windows or generated graphs, so export either of these 
items before closing the windows.  See (Fig. 17).

Although i-Star saves all project data entered in the application, as a fur-
ther safeguard against data loss, keep the original source files and periodically 
back up all i-Star projects. 

Press Ctrl + s or select “Save Project” in “Project“ menu.
Choose a filename for the project. 
Click “Save” button.

Fig. 17
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WIR i-Star contains a custom report creation utility, allowing the creation 
of PDF reports for the analyzed data.  This tutorial shows the steps taken to 
create a standard WIR report using the i-Star application.

Click on ‘PDF Report Preview Window’ under “View” menu.  See (Fig. 
18).

Fig. 18

The Summary page of the PDF Report Preview window will appear.  The 
first page on the PDF will contain a summary of the project details.  The 
filename text box displays the name of the PDF.  Choose a name suitable 
for the project.  In this example, name the PDF “WIR_oemvs3party.isf_re-
port_2007_12_14.pdf.”  The remaining three check boxes and corresponding 
text boxes designate the location of the PDF file.  For this example, place the 
PDF in the same folder as the project.  Check the “at project folder” check box.  
The remaining entries, colored white, must be filled from the “Preferences” 
page under the “Project Info” tab.  These fields are not required, but provide 
more detail about the nature of the project.  All yellow fields (text boxes) may 
be directly modified from the PDF Report page.  Be sure the “Wilhelm Imag-
ing style (short)” radio button is checked.  This is the reporting format of a 
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standard Wilhelm Imaging Research report.  See (Fig. 19).

Fig. 19

The check boxes on the right side of the PDF Report Preview show which 
pages are included in the current “Report Preset” selection (in this case Wil-
helm Imaging style short).  The buttons to the right of the check boxes allow 
you to preview the pages before printing the PDF.  A green label on the but-
ton indicates that you are currently viewing the page represented by that but-
ton.  In order to view a particular page, the corresponding check box must be 
checked (i.e. that page must be included in the PDF report).  

Complete the “Printer,” “Ink,” “Media,” and supplemental information 
text boxes.  See (Fig. 19).  Check the Wilhelm Imaging style (short) radio but-
ton.  This is the preset reporting format present in standard Wilhelm Imaging 
Research reports.  
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The text boxes colored in white must be filled from the “Preferences Page.”  
See (Fig. 20).

Once the “Preferences Page” is complete, the corresponding fields will 
auto fill in the PDF Report preview page.  The supplemental information may 
be entered manually into the PDF Report page, indicated by a yellow text 
area.  Write a short sentence to elaborate on details of the project in the sup-
plemental information area.

View the “Test Information” page of a standard WIR i-Star Report.  See 
(Fig. 21).  Notice for this test, the Light level (Lux) data box is left empty.  In 
this case, the light level has no effect on the comparison results between the 
two prints.  The light level fields become relevant when using i-Star to analyze 
image exposure to other elements (e.g. light, ozone etc).  An example defining 
conditions, time of exposure, and periodic readings of an image is explained 
in another tutorial.

 A detailed explanation of each page and its corresponding text field is in-
cluded in the i-Star User Guide.

Fig. 20



17

OEM vs Third-Party Tutorial

Comparison of OEM vs Third-Party Inks

Tutorial 4 (Rev. 2010-01-01)

After reviewing the PDF preview, click “Create PDF Report” button to 
print the PDF. 

Continue exploring i-Star.  Explanations of other controls, including those 
for the “Main Settings” page, are available in the User i-Star Manual for refer-
ence.  When done, press Ctrl + q or choose “Quit” in the “i-Star” menu.  Save 
any additional changes to the project.

Fig. 21


